This chapter tells how to use the ADM application for the administrator function.

4.1	Opening the Application

To open the application:

1.	Run Windows 95 (or Windows NT 4.0).

2.	Click on Start.

3.	Highlight Programs.

4.	From the Program list, move the highlight bar to Acer ADM Management Console.

From the Advanced Desktop Manager group, click on ADM v2.0 Administrator Version.

6.	If this is your first time to run the application, you will be prompted to set a login password.  The password prevents unauthorized access to ADM.  Enter your password in the New Password text box.  Your password must contain not exceed eight characters.  

�

Figure 4-1	Set Password Dialog Box

	Type the same password in the Confirm Password text box.  This helps you check whether you have set the correct password.

	If this is not your first time to run the application, the following password prompt appears:

�

Figure 4-2	Password Dialog Box

	Enter your login password in the Password text box.

8.	Click on OK to accept your settings.  Click on Cancel to disregard.

9.	After you click on OK, the ADM v2.0 Administrator main screen appears on your screen.

�4.2	ADM Administrator Main Screen

The following figure shows the ADM Administrator main screen:

�

Figure 4-3	ADM Administrator Main Screen

By default, the application displays the Machine List viewer.  The Machine List viewer shows the systems that are currently connected to the network and can be monitored by the administrator.  

The following are the parameters displayed in the Machine list viewer: 

Machine List Viewer

Name�Shows the name of the monitored machine��Operating System�Shows the operating system currently installed in the monitored machine��IP Address�Shows the IP address of the monitored machine��Protocol�Shows the management protocol used between the management machine and monitored machine ��Description�Shows the information about the DMI Service Layer vendor��The Machine List may change from time to time.  To make sure that you have the updated list, click on the AutoDiscovery button.  For more details, refer to section 4.2.1.

4.2.1	Menu Bar

The Menu bar contains the following menus:

File Menu

The File menu includes the following commands:

Autodiscovery

The AutoDiscovery command enables ADM to automatically search for the machines in the local area network with ADM Local package installed.   

Change Password

Selecting this command opens the Change Password Dialog Box.  This lets you change your ADM login password.  

Before you change your password, you will be prompted to enter your current login password in the Password dialog box (see Figure 4-2).  After entering your password, the Change Password dialog box appears.  

�

Figure 4-4	Change Password Dialog Box

In the New Password text box, enter your new password.  Enter the same password in the Confirm Password, then click on OK. 

reboot

The Reboot command enables you to restart the currently monitored machine, i.e., the selected machine in the Machine List window. 

Shutdown

Selecting this command shuts down the currently monitored machine, i.e., the selected machine in the Machine List window.

Exit

This command closes the ADM program window.  

�View Menu

The View menu includes the following options:

Toolbar

This option lets you display or hide the toolbar, i.e., the buttons for some of the most common ADM commands that usually appear just below the menu bar.  When the toolbar is displayed, a check mark appears beside the command item.

�

Figure 4-5	Toolbar

Status Bar

This option lets you display or hide the status bar, i.e., the bar located along the bottom of the ADM program window.  When the status bar is displayed, a check mark appears beside the command item.

�

Figure 4-6	Status Bar

�Information bar

This option lets you display or hide the information bar, i.e., the bar located on the left side of the ADM program window that contains buttons.  These buttons allow you to open windows that contain the monitored system’s hardware and software information.  When the information bar is displayed, a check mark appears beside the command item.

�

Figure 4-7	Information Bar

�Information Menu

The Information menu includes the following options:

PC Monitor

Choosing this option opens the PC Monitor window.  This window shows the current condition of the monitored machine based on predefined criteria.

�

Figure 4-8	PC Monitor Window:  Resource Page

Resource Page

GDI (Graphic Device Interface)

Size�Specifies the amount of kernel resources  (in megabytes) allocated for GDI.  ��Free (%)�The percentage of kernel resources available in the system.����The GDI function is not supported under Windows NT 4.0.  ��Warning Threshold�Specifies the value that ADM must use as reference to check the GDI resource utilization.  If the percentage of free resources falls below this value, it points to slight irregularities in the system causing ADM to execute predefined actions to inform you of the condition.��Critical Threshold�A specified value lower than the Warning Threshold referred to by ADM to check the GDI resource utilization.  If the percentage of free resources falls below this value, it points to more serious abnormal conditions in the system causing ADM to execute predefined actions to inform you of the status, correct the condition or prevent damage.��Virtual Memory

Size�Specifies the amount of kernel resources (in megabytes) allocated as virtual memory.��Free (%)�The amount of unused virtual memory space in megabytes.��Warning Threshold�Specifies the value that ADM must use as reference to check the virtual memory utilization.  If the percentage of free resources falls below this value, it points to slight irregularities in the system causing ADM to execute predefined actions to inform you of the condition.���

Critical Threshold�A specified value lower than the Warning Threshold referred to by ADM to check the virtual memory utilization.  If the percentage of free resources falls below this value, it points to more serious abnormal conditions in the system causing ADM to execute predefined actions to inform you of the status, correct the condition or prevent damage.���

Figure 4-9	PC Monitor Window:  Storage Page

Storage Page

Drive�Specifies the system’s drive name.��Total Size�Specifies the drive capacity in megabytes.��Free Size�The amount of unused disk space in megabytes.��Warning Threshold (MB)�Specifies the value that ADM must use as reference to check the storage utilization.  If the percentage of free resources falls below this value, it points to slight irregularities in the storage device causing ADM to execute predefined actions to inform you of the condition.��Critical Threshold (MB)�A specified value lower than the Warning Threshold referred to by ADM to check the storage utilization.  If the percentage of free resources falls below this value, it points to more serious abnormal conditions in the storage device causing ADM to execute predefined actions to inform you of the status, correct the condition or prevent damage.���

Figure 4-10	PC Monitor Window:  Fan Page

Fan Page

Type�Specifies the type and function of the fan that is being monitored, e.g., system fan, CPU fan.��Status�Specifies the current status of the fan.  Possible setting may either be Normal or Critical.���

Figure 4-11	PC Monitor Window:  Temperature Page

Temperature Page

Type�Specifies the component that is being monitored.��Status�Specifies the current status of the monitored component.  Possible setting may either be Normal or Critical.���

Figure 4-12	PC Monitor Window:  Voltage Page

Voltage Page

Type�Displays the various voltage levels monitored.��Status�Specifies the current status of the monitored voltage.  Possible setting may either be Normal or Critical.���

Figure 4-13	PC Monitor Window:  ECC Page

ECC Page

Status�Specifies the current status of the ECC function.  Possible setting may either be Normal or Critical.���BAsic System Information

Selecting this option opens the Basic System Information window.  This window contains information about the monitored system’s hardware and software.

 �

Figure 4-14	Basic System Information Window

Desktop PC

Manufacturer�Shows the manufacturer of the desktop PC.��Product Name�Shows the monitored system’s product name.��Asset Tag�Shows the monitored system’s asset tag number.��Serial No.�Shows the system’s serial number.��System

Computer Name�Shows the name of the PC specified by the user.��Network Address�Shows the PC’s Internet Protocol (IP) address.��BIOS

Vendor�Displays the vendor of the BIOS installed in the system.  ��Version�Displays the version information of the BIOS.��Release Date�Displays the release date of the BIOS version. ��Operating System

Name�Shows the currently installed OS.��Version�Shows the OS version information.��Processor

Vendor�Displays the vendor of the processor currently installed in the system. ��Family and Speed�Displays the processor type and speed.��Physical Memory

Total Memory�Specifies the total amount of memory that the system supports.��Maximum Memory Capacity�Specifies the installed memory size.��SIMM Slots No.�Specifies the total number of SIMM slots in the system.��SIMM Slots Used�Specifies the number of occupied SIMM slots.��Basic Hardware Information

Selecting this option opens the Basic Hardware Information window.  This window shows the DMI BIOS related data.  When the PC reboots, the DMI BIOS detects the monitored system’s hardware configuration and keeps these data in a predefined area in the BIOS memory. 

 �

Figure 4-15	Basic Hardware Information Window:  BIOS Page

�BIOS Page

BIOS Vendor�Displays the vendor of the BIOS currently installed in the system.��Version�Displays the version information of the BIOS.��ROM Size�Displays the installed BIOS ROM size, normally 64K.��Release Date�Displays the release date of the PC’s BIOS version.��Starting Address Segment�Displays the installed BIOS starting address, normally 0XF000.��Boot Support�Displays the different boot methods supported by the BIOS such as Selectable Boot, Boot from CD, or Boot from PCMCIA.��Bus Support�Displays the bus types supported by the installed BIOS (ISA, EISA, PCIMCA, �VL-VESA, PCMCIA).��Other Features Support�Displays a list of features supported by the installed BIOS.  From this list, click on the BIOS features that you want to support.��Other Devices�Displays a list of system devices.  From this list, click on the devices that your system supports.��INT 13h Floppy Support�Displays a list of supported floppy drives.  From this list, click on the floppy drives currently installed in your system.���

Figure 4-16	Basic Hardware Information Window:  Baseboard Page

Baseboard Page

Manufacturer�Shows the manufacturer of the system’s baseboard.���Product Name�Shows the baseboard’s product name.���Serial No.�Shows the baseboard’s serial number.���Version�Shows the baseboard’s version number.����

Figure 4-17	Basic Hardware Information Window:  Processor Page

Processor Page

Processor Type�Shows the type of the processor currently installed in the system.��External Clock�Displays the processor’s external clock speed.��Maximum Speed�Displays the maximum speed that the processor can support (in MHz).���Current Speed�Displays the current speed of the processor (in MHz).���Manufacturer�Displays the manufacturer of the CPU installed in the system.���

Processor Upgrade�Describes the possible upgrade method that can be used for upgrading the CPU.���Processor Family�Displays the processor family where the processor belongs.���Version�Displays the processor version.����

Figure 4-18	Basic Hardware Information Window:  Memory Controller Page

Memory Controller Page

Err. Detecting Method�Displays the error detecting method used by the system’s memory controller.��Err. Correcting Capability�Displays the error correction method used by the memory controller.��Interleave Support�Specifies the interleave types supported by the selected memory controller, i.e.,  Other, Unknown, One Way Interleave, Two Way Interleave, Four Way Interleave, Eight Way Interleave, or Sixteen Way Interleave.��Current Interleave�Shows the interleave type currently supported by the memory controller.��Max. Memory Module Size�Displays the maximum memory size in megabytes that the memory controller supports.��Support Speed�Specifies the memory speed supported by the controller.��Support Type�Specifies the memory module type supported by the controller.��Memory Module Size�Specifies the maximum memory module size that a single memory slot can support.��No. of Associated Memory Slot�Displays the number of memory slots that the memory controller handles.���

Figure 4-19	Basic Hardware Information Window:  Memory Module Page

Memory Module Page

Socket Designation�Specifies the string assigned to the memory socket.��Bank Connection�Specifies the number of SIMM slots per bank.��Current Speed�Specifies the speed of the memory module installed in the system.��Current Type�Displays the physical characteristics of the memory modules installed in the system.��

Installed Size�Displays the total memory size of the modules installed in the system �(in megabytes). ��Enable Size�Displays the enabled memory size in megabytes. ��Error Status�Specifies the correctable errors received from the module.���

Figure 4-20	Basic Hardware Information Window:  Cache Page

Cache Page

Socket Designation�Specifies the string assigned to the cache socket.��Max. Size�Displays the maximum cache size supported.��Installed Size�Displays the cache size installed in the system.��Supported SRAM Type�Displays the SRAM types supported by the system.��Current SRAM Type�Specifies the SRAM type currently supported by the system.���

Figure 4-21	Basic Hardware Information Window:  Port Connector Page

Port Connector Page

Internal Reference�Specifies the internal reference string.��Internal Connector Type�Displays the internal connector specification.��External Reference�Specifies the external reference string��External Connector Type�Displays the external connector specification.��Port Type�Describes the function of the port.���

Figure 4-22	Basic Hardware Information Window:  Slot Page

Slot Page

Slot Designation�Specifies the string assigned to the slot.��Type�Displays the slot’s type.��Data Bus Width�Displays the slot’s data bus width.��Current Usage�Displays the slot’s usage status.��Slot Length�Displays the slot’s length.��Slot ID�Specifies the slot whether it is MCA, EISA, PCI, or PCMCIA.��Characteristics�Displays the voltage used and slot sharing, e.g., PCI/ISA.���

Figure 4-23	Basic Hardware Information Window:  Onboard Device Page

Onboard Device Page

Device Type�Specifies the type of device installed on board, e.g., Video, SCSI, Ethernet, Token Ring, and Sound.��Description�Shows a brief description of the device.��Storage Information

Selecting this option opens the Storage Information window.  This window displays the status of the drives installed in the monitored system, including the external or network mapped drives.

�

Figure 4-24	Storage Information Window:  Physical Disk Page

Physical Disk Page

Disk

Type�Specifies the media type, e.g., CD-ROM, diskette, hard disk.��Index�Displays the index number for each disk type.��Parameters

Interface Type�Specifies the storage interface, e.g., Floppy, IDE, SCSI.��Media Loaded�Checks whether the disk is loaded.  Possible value is either Yes or No.��Removable Drive�Checks whether the disk is removable or fixed.  Possible value is either Yes or No.��Cylinders�Specifies the number of cylinders in the disk.��Sector/Cylinder�Specifies the number of sectors on the disk.��Heads�Specifies the number of heads on the disk.��Bytes/Sector�Specifies the number of bytes per sector.��Total Size�Displays the total disk capacity in kilobytes.��No. of Partitions�Specifies the number of partitions created on the disk.��Physical Location�Indicates where the disk is currently installed.��Partitions

Name�Specifies the disk partition name.��Size�The partition size in kilobytes.��Free Space�Displays the amount of unused disk space in kilobytes.��File System�Specifies the file system that the disk supports.���

Figure 4-25	Storage Information Window:  Logical Disk Page

Logical Disk Page

Drive�Specifies the logical drive’s letter and name.��Type �Displays the logical drive’s media type.��Total Size�Shows the drive capacity in kilobytes.��Free Size�Specifies the amount of available disk space in kilobytes.��System REsource Information

Selecting this option opens the System Resource Information window.  This window displays the resources available in the monitored system.

 �

Figure 4-26	System Resource Window

Device Name�Displays the installed device.��IRQ�Displays the IRQ assigned to the device.��DMA�Displays the DMA channel assigned to the device.��I/O Port�Displays the I/O port occupied by the device.��Memory Address�Displays the base memory occupied by the device.��Manufacturer�Displays the device manufacturer.��I/O Peripheral Information

Selecting this option opens the I/O Peripheral Information window.  This window shows the address, IRQ, port assigned, and specification of the I/O devices present in the monitored system.

 �

Figure 4-27	I/O Device Information Window:  I/O Port Page

I/O Port Page

Serial Ports

Name�Specifies the ports ( such as COM1, COM2, or LPT1 ) available in the system.��Address�Displays the base I/O address of the port.��IRQ�Displays the IRQ assigned to the port.��Capability�Displays the distinct feature of the port (Other, Unknown, XT/AT compatible, 16450 compatible, 16550 compatible, 16550A compatible for serial port. . XT/AT compatible, PS/2 compatible, ECP, or EPP for parallel port. ).��Description�Displays information about the port���

Figure 4-28	I/O Device Information Window:  Keyboard and Mouse Page

�Keyboard and Mouse Page

Keyboard

Type�Displays the type of keyboard currently connected to the system.��Connector Type�Displays the type of keyboard connector supported by the system. ��Layout�Displays the layout type of the keyboard.��Mouse

Manufacturer�Specifies the device manufacturer.��Interface�Displays the mouse interface type that the system supports.��IRQ�Specifies the IRQ assigned to the mouse device.��Buttons�Displays the number of mouse buttons.��Port Name�Specifies the port currently occupied by the mouse device.��Driver Name�Displays the name of the mouse driver.���

Figure 4-29	I/O Device Information Window:  Video Page

Video Page

Manufacturer�Displays the manufacturer of the video card currently installed in the system.��Model�Displays the video card model number.��Driver Name�Displays the name of the video driver used.��Driver Version�Specifies the video driver version.��Current Resolution�Displays the currently supported video resolution of the VGA card.��Current Colors�Specifies the currently supported video colors of the VGA card.��

Resolutions Supported�Displays the different video resolutions that the video card supports.  This function is NOT supported under Windows NT.��Network Information

Selecting this option opens the Network Information window.  This window shows the current network configuration of the monitored system.

 �

Figure 4-30	Network Information Window

Network Card 

Manufacturer�Displays the manufacturer of the system’s network card.��Model�Shows the model number of the network card.��Driver Name�Displays the network driver used by the network card.��Driver Version�Displays the network driver version.��Description�Displays a brief description of the system’s network card.��TCP/IP

TCP/IP Address�Specifies the IP address assigned to the system.��Net Mask�Specifies the subnet mask number assigned to the monitored machine.��Primary Gateway�Displays the IP address of the primary gateway in the LAN to which the monitored system belongs.��DNS Servers�Displays the IP addresses of the available DNS Servers.���Utilization Information

Selecting this option opens the Utilization Information window.  This window shows how the monitored system uses its resources, device and components.

 �

Figure 4-31	Utilization Information Window:  Kernel Page

Kernel Page

Thread Created�Specifies the total number of threads created.��Virtual Machines Created�Specifies the number of virtual machines created.��CPU Utilization (%)�Displays the processor’s percent utilization.���

Figure 4-32	Utilization Information Window:  Memory Manager Page

Memory Manager Page

Allocated Memory�Shows the total amount of memory allocated in the system.��Locked Memory�Shows the amount of memory locked.��Swappable Memory�Shows the number of memory bytes allocated from the swapfile.��Free Memory �Displays the amount of available memory.��Other Memory�Displays the number of memory bytes which are not stored in the swapfile such as disk cache, pages, memory allocated fixed (non-pageable), and memory mapped files.��Disk Cache

Max. Size�Displays the maximum disk cache size supported.��Min. Size�Displays the minimum disk cache size supported.��Current Size�Displays the disk cache size detected by ADM.��Swapfile

Defective�Shows the number of bytes on the swapfile currently in use.��In Use�Shows the number of bytes on the swapfile currently in use.��Size�Shows the swapfile size in bytes.��Paging

Page Discards�Specifies the number of pages discarded per second.��Page Faults�Shows the number of page faults per second.��Page In�Shows the number of page-in operations performed per second.��Page Out�Shows the number of page-out operations performed per second.���

Figure 4-33	Utilization Information Window:  File System Page

File System Page

Bytes Read Per Sec.�Specifies the number of bytes read per second from the file system.��Bytes Write Per Sec.�Specifies the number of bytes written per second from the file system.��Reads Per Sec.�Displays the number of read requests made to the file system per second.��Writes Per Sec.�Displays the number of write requests made to the file system per second.���

Figure 4-34	Utilization Information Window:  IPX/SPX Page

IPX/SPX Page

IPX Packet sent/second�Shows the number of IPX packets sent on the network per second.��IPX Packets received/second�Shows the number of IPX packets received from the network per second.��IPX Packets lost/second�Shows the number of IPX packets received from the network that were dropped because nobody on the local system wants them.��SPX Packets sent/second�Specifies the number of SPX packets sent per second.��

SPX Packets received/second�Specifies the number of SPX packets received per second.��Open Sockets�Shows the number of open sockets available.��Routing Table Entries�Displays the number of IPX Internetworking routes detected available.��SAP Table Entries�Displays the number of service advertisements detected.���

Figure 4-35	Utilization Information Window:  Mass Storage Page

Mass Storage Page

Total Space�Displays the total storage capacity of the system (in megabytes).��Free Space�Displays the amount of unused storage space in megabytes.��Space Used (%)�Displays a pie chart indicating the percentage of storage space used.��Operating system INformation

Selecting this option opens the Operating System Information window.  This window shows all OS-related data, including the programs and drivers currently present in the monitored system.

 �

Figure 4-36	Operating System Information Window:  Environment Variables Page

�Environment Variables Page

This page lists the environment variable settings of the monitored system.

�

Figure 4-37	Operating System Information Window:  Task List Page

Task List Page

Windows Tasks

Task Name�Lists all windows operations currently running in the system.��Type�Specifies the operation type, e.g., 16-bit, 32-bit.���Real Mode Tasks

Task Name�Displays the DOS task name���

Figure 4-38	Operating System Information Window:  Drivers Page

Drivers Page

Driver Name�Lists all drivers currently loaded in the system.��Type�Specifies the driver type, e.g., 16-bit, 32-bit.���Tools Menu

The Tools menu includes the following options:

Event Log 

This option opens the Event Log window.  This window lists all events that occurred in the monitored system, the component from which the event occurred, the occurrence time, and the event ID.

�

Figure 4-39	Event Log Command Window

Notification Log

Issued from�Displays the component ID from which the event occurred.  ��Description�Displays a brief description of the event.��Event Time�Displays the time when the event occurred.  ��Event ID�Displays the event ID.��To show the status of the each event that occurred, the following icons are used:

� EMBED Word.Picture.6  ����Normal ����Warning����Critical��To clear the Event Log window, simply click on the Clear button.

System File Editor

Selecting this option opens the System File Editor window that allows you to modify system files in the monitored system.  

�

Figure 4-40	System File Editor Window

The list box on the left displays all system files in the system, while the box on the right displays the contents of the selected system file.

To modify a system file:

1.	From the left list box, select the system file that you want to modify.

2.	Click on the Get File button.  The right box displays the contents of the selected file.

3.	Make the necessary modifications on the file.

4.	After making the modifications, click on the Put File button to save the changes.

��If you close the window without clicking the Put File button, changes will not be saved to the system file.���General Configuration

Selecting this option opens the General Configuration window that allows you to set the access priveleges of the administrator.  

�

Figure 4-41	General Configuration Window

The administrative priveleges offered are as follows:

Administrator can Remotely Configure the System�Allows the administrator to configure the monitored system.��Administrator can Remotely Edit System Files�Allows the adminitrator to modify the system files such as AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, SYSTEM.INI, etc.  in the monitored system.��Administrator can Remotely Shut Down this System�Allows the administrator to shut down the monitored system.��Administrator can Remotely Reboot this System�Allows the administrator to restart the monitored system.��Threshold Configuration

Selecting this option opens the General Configuration window.  This window allows you to set the warning and critical threshold levels (i.e., the resource status level that when reached, a warning or a critical message is issued) for GDI, VM resources and storage of the monitored system.  

�

Figure 4-42	Threshold Configuration Window:  Kernel Page

�Kernel Page

GDI Threshold

Warning Level�Specifies the percentage (from 0 to 100) limit of free GDI resources.  One the percentage falls below the specified value, ADM will execute predefined actions to inform you of the condition.��Critical Level�Specifies the percentage (from 0 to 100) limit of free GDI resources.  Once the percentage falls below the specified value, ADM will execute predefined actions to inform you that your GDI resources have reached the critical level.����The GDI Threshold function is not supported under Windows NT 4.0.  ��VM Threshold

Warning Level�Specifies the percentage (from 0 to 100) limit of free virtual memory.  One the percentage falls below the specified value, ADM will execute predefined actions to inform you of the condition.��Critical Level�Specifies the percentage (from 0 to 100) limit of free virtual memory.  Once the percentage falls below the specified value, ADM will execute predefined actions to inform you that your virtual memory is in critical status.����The Critical Level Threshold can not be greater than the Warning Level Threshold.���

Figure 4-43	Threshold Configuration Window:  Storage Page

Storage Page

Drive�Displays the logical drive letter and name.��Total Size (MB)�Displays the drive capacity.��Free Size (MB)�Specifies the amount of unused space on the drive.��Warning Threshold (MB)�Displays the current Warning Threshold setting.��Critical Threshold (MB)�Displays the current Critical Threshold setting.���

Warning Level�Specifies the amount of free memory in megabytes for Warning Level Threshold.  If the amount of free memory falls below this value, ADM will execute predefined actions to inform you of the condition.��Critical Level�Specifies the amount of free memory in megabytes for Critical Level Threshold.  If the amount of free memory falls below this value, ADM will execute predefined actions to inform you of the condition.����The Critical Level Threshold can not be greater than the Warning Level Threshold.��Window Menu

The Window menu includes the following commands:

Cascade 

This command arranges multiple opened windows in an overlapped manner.

Tile

This command arranges multiple opened windows in such a way that all windows appear on the screen.  

arrange Icons

This option arranges the icons for minimized windows at the bottom of the main window.  If there is an open window at the bottom of the main window, some or all of the icons will be placed underneath this window  and therefore, may not be seen on the screen. 

machine list

This option sets the Machine List window as the ADM default window.  If enabled, a check mark appears next to the item.  To disable, simply click on the Machine List option again, then the check mark disappears.

Help Menu

This menu lets you open and display the ADM Help topics.  From this screen, you can view the ADM help information.

4.2.2	Toolbar

The Toolbar is the bar that appears just below the menu bar.  This contains some of the most common ADM commands and these are as follows:

��Monitored System Name�Shows the name of the currently monitored system..����AutoDiscovery�Automatically searches for the machines in the local area network with ADM Local package installed (similar to the File menu’s AutoDiscovery command - refer to section 4.2.1).���

��PC Monitor�Opens the PC Monitor window.  This window shows the current condition of the monitored machine based on predefined criteria (similar to the Information menu’s PC Monitor option - refer to section 4.2.1).  ����Event Log�Opens the Event Log window.  This window lists all events that occurred in the monitored system, the component from which the event occurred, the occurrence time and the event ID (similar to the Tool menu’s Event Log option - refer to section 4.2.1).����System File Editor�Opens the System File Editor window that allows you to modify system files in the monitored system (similar to Tool menu’s System File Editor option - refer to section 4.2.1). ����General Configuration�Opens the General Configuration window that allows you to set the access priveleges of the administrator (similar to the Tool menu’s General Configuration option - refer to section 4.2.1).���

��Threshold Configuration�Opens the General Configuration window.  This window allows you to set the warning and critical threshold levels (i.e., the resource status level that when reached, a warning or a critical message is issued) for GDI, VM resources and storage of the monitored system (similar to Tool menu’s Threshold Configuration option - refer to section 4.2.1).����Help�Opens the ADM Help file (similar to the Help menu - refer to section 4.2.1).��4.2.3	Information Bar

The Information bar is the bar located on the left side of the ADM program window. Similar to the Toolbar, it also contains buttons that allow you to open windows containing important information regarding the monitored system.  

The following lists the command buttons found on the Information bar:

��Basic System Information�Opens the Basic System Information window.  This window contains information about the monitored system’s hardware and software (similar to the Information menu’s Basic System Information option - refer to section 4.2.1).���

��Basic Hardware Information�Opens the Basic Hardware Information window.  This window shows DMI BIOS related data.  When the PC reboots, the DMI BIOS detects the monitored system’s hardware configuration and keeps these data in a predefined area in the BIOS memory (similar to the Information menu’s Basic Hardware Information  option - refer to section 4.2.1).����Storage Information �Opens the Storage Information window.  This window displays the status of the drives installed in the monitored system, including the external or network mapped drives (similar to the Information menu’s Storage Information option - refer to section 4.2.1)����System Resource Information�Opens the System Resource Information window.  This window displays the resources available in the monitored system (similar to the Information menu’s System Resource option - refer to section 4.2.1)����I/O Peripheral Information�Opens the I/O Peripheral Information window.  This window shows the address, IRQ, port assigned, and specification of the I/O devices present in the monitored system (similar to the Information menu’s I/O Peripheral Information option - refer to section 4.2.1).��

��Network Information�Opens the Network Information window.  This window shows the current network configuration of the monitored system (similar to the Information menu’s Network Information option - refer to section 4.2.1).����Utilization Information�Opens the Utilization Information window.  This window shows how the monitored system uses its resources, device and components (similar to the Information menu’s Utilization Information option - refer to section 4.2.1).����Operating System Information�Opens the Operating System Information window.  This window shows all OS-related data, including the programs and drivers currently present in the monitored system (similar to the Information menu’s Operating System Information option - refer to section 4.2.1).���4.3	Trap Monitor Window

After you have installed the ADM Administrator package, the ADM monitoring function is automatically enabled once you turn on the system.  This monitoring function allows you to check the status of the systems detected by the administrator, with or without enabling the installed ADM.  Therefore, once an error is detected from any of the local systems, a window specifying the system where the error occurred, the error description, the occurrence time, and the event ID automatically pops up on the screen.  This window is called as Trap Monitor window.

The following figure shows how a Trap Monitor window appears on the screen if ADM is not running. 

�

Figure 4-44	Trap Monitor Window (ADM Disabled)

If you want to run ADM at once, click on Yes.  If not, click on Cancel to close the window. 

�If ADM is running, the Trap Monitor window appears as follows:

�

Figure 4-45	Trap Monitor Window (ADM Running)

Click on Cancel to close the window. 

Parameters:

Issued from�Displays the local system ID from which the event occurred.  ��Description�Displays a brief description of the event.��Event Time�Displays the time when the event occurred.  ��Event ID�Displays the event ID.��
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